
TreeThing – Basic Tutorial
Let's start by opening up whatever program you use to paint your maps – Photoshop, Gimp, 
Paintshop Pro... whatever. As long as it is capable of saving .png files with transparency intact 
then it's cool.

Here is a section from a map that I want to have forested. (fig 1)

fig. 1

With a brush, working in whatever colour you want, paint in where you want your forest(s) to 
be. This will be your template. (fig .2)

fig. 2

I've given mine some lower opacity sections so that I can utilise some of the template functions 
in the program. You don't need to do this. You can have it all at 100% opacity with hard edges 
if you like.



The template can be very large in size (tested up to 5k x 5k dimension) but be aware that the  
larger it is the slower the program will run and the harder it will be to notice any spots you are  
not happy with in the forest generation.

Fig. 3 shows the forest template without the map behind:

fig. 3

(Unfortunately I saved this a .jpg for the purpose of this tutorial so you cannot see on this image  
that the surrounding area around the forests needs to be left transparent.)

Save the forest template as a .png file.

Now, open up TreeThing. You should be greeted with a screen thus:

fig. 4



Here everything is set to the default parameters, including the brush set.

At the top is the menu bar. All the commands for basic control of the program are here.
In the middle is the view port. It's coloured green only for visibility sake.
At the bottom is the control bar. This is used for adjusting or fine-tuning the parameters of 
the various controls

We want to load up our forest template in to the program. So from the File menu click on 
Import Template and then browse to where you saved your template .png file. (fig. 5)

Fig. 5

The template size is larger than the viewing area so it is off the sides. You can drag the window 
edges so the view port is larger. You can also use a scroll wheel to change the size at which the 
forests are shown (this doesn't effect the output of the forest – just visually in TreeThing).
You can also click inside the view port and drag the forest around.

Next I want to change the brush set.

There are four brush sets currently included with the TreeThing zip. The default set as seen 
above. There is a coloured version of the default set which uses multiple instances of the same 
tree brush but adds colour to them. There is a coniferous tree set and then there is the Vaniya 
brush set, which is what I'm going to use now.
You can also create your own brushes to go with the program. Brush creation is described in a  
separate tutorial.



From the File menu again click on Change Brush Directory and then browse to whichever 
directory holds the brushes you require. (fig. 6)
Depending on how many brushes the set holds, it can take a second or two to load them up so  
don't worry.

Fig. 6

You can see I've dragged the viewing window larger to see more of the forest and that the 
trees have changed.

If you want to view the separate layers that can go into making a forest the you can select 
them from the View menu. Each layer can be viewed separately or several can be combined 
together. 

Here you can see the forest with the shade and shadow layers also visible. (fig. 7)



Fig. 7

So there, at their most basic, are my forests. I could save the layers now and load them into 
my paint program to complete the process.

To save our generated forests we simply go into the File menu once again and select from the 
two save options available:

• Save All Layers   saves each of the available layers into different transparent .png files. 
It doesn't matter if the layer is visible or not – as long as the brush set has the requisite 
files (mask, shade and shadow) the layer will be saved.

• Save Visible Layer   will save the image exactly how it is shown in the view port (minus 
the green background of course.)



Making Your Forests a Little More... Random
The previous example forest works but it only takes one look at it to see that it is computer 
generated. The diagonals are completely straight. That may be OK for you but I'd like to mix 
it up a bit and make those trees look a little more hand-placed. We have a few ways of 
achieving this. We can vary the size of the trees which helps fool the eye that the trees aren't 
perfectly in line. And we also have jitters.

Jitters are used to jitter the position of a tree by small amounts to make their placement less 
uniform.

If you look in the Jitter menu you can see that there are currently six different jitters. The 
most basic jitters are: X-Jitter and Y-Jitter. They pick a random number from within a given 
parameter and then a random direction and move the trees accordingly. They take no account 
of where the other trees are around them.

Next are the accumulative jitters. These move the trees by a random amount from within a 
given parameter in a random direction along the given axis but have a knock-on effect with 
the trees next to them. A small overlap is allowed (to allow it to have an effect when the forest 
density is tight) but there should be far less “misplaced” trees.

Lastly there are the diagonal jitters. These move a whole diagonal line of trees by a random 
amount from within a given parameter and in a random direction along their current vector. 
This can give the resultant diagonals a nice curved effect.

Each of these jitters has a default value based on the current size of the tree but if you want to 
change that value, give it more or less jitter, then you can by using the control bar at the 
bottom.
You can activate a jitter by either clicking on it from the Jitter menu or you can also navigate 
to the required jitter using the control bar.

When you have the required jitter (or any adjustable function) displayed in the control bar, 
use the spinner to alter the value and press Reshuffle to use it.

(A quick note on the two buttons Generate and Reshuffle

The Reshuffle button works by re-applying only the currently selected control to the forest*. So if 
you like your generated positions how they are and want to make changes to your forest one 
control at a time, use the Reshuffle button.
The Generate button reapplies all currently active controls and also re-randomises tree positions 
and brushes.

*The only time Reshuffle will act like Generate is when Density is selected. Changing the density of 
the forest alters too much for the other controls not to be reapplied.)

OK, less talk, more examples.

The first thing I'm going to do is alter the density of my forest. At the moment the trees are 
packed in almost as tight as they'll go. The closer the trees are, the less  they can be jittered 
before they overlap in strange places and look odd.



So I select Density from the control bar at the bottom.
In fig.10 you can see I have increased the density on both axis to 3. (As was said before, you 
can use either the Reshuffle or Generate buttons where density is concerned – it's all the 
same.)

Fig. 8

That gives me a little more room to play with.

Now I'll play with the jitters. The density is still pretty close so I cannot go too wild here.

In fig.9 I've added: Y-Jitter, Accumulative X-Jitter, Right-Left Diagonal Jitter and Left-Right 
Diagonal Jitter all at their default values.



Fig. 9

You can certainly get good looking forests by increasing all the jitters you use, even at a close 
density, but the odds of it creating areas that look wrong are that much higher. As it is, there 
are a few places in the above image that I can see trees overlapping where I don't particularly 
want. It looks acceptable though.

You should be able to see that the forest now looks a lot more random. At first glance it looks 
fine but if you look at the diagonals you can see they are still reasonably straight and well-
defined.

Note that in some areas, especially the small forests the amount of trees has varied or positions 
may have changed entirely at the edges. This is because the jitters have taken some of the 
trees out of the area where the template is and in other places has moved trees in to the 
template.

Right, in order to make it appear a little more random (although not actually) we will vary the 
scale in the trees.



Click on the left combo box in the Control Bar and select Scale. 
If you now look in the sub-menu combo box you have the options: Brush Size, Second Brush 
Size and Weight.
The two brush size controls gives it a maximum and minimum tree size to use. The program 
will then randomly choose tree sizes from between (and including) those two parameters.
The Weight control is used to bias the randomness towards either the larger or smaller of the 
two sizes.

There is a reason why the two controls aren't called simply “maximum” and “minimum.” 
Depending on which control you decide to make the larger size, it effects how the program will 
draw the forests.

The program works out all its spacing of the trees from the first brush control. The space allotted to 
each tree will be relative to this size, no matter how big the tree ends up. So, if you give the first 
brush control  a larger value than the second, all the smaller trees will have a space around it. 
Consequently, if you give the first control a smaller value than the second one, the trees that are 
larger in the forest will all be surrounded tightly by other trees.
Each way has its own appearance and its just up to you to play around and see which way you 
prefer or fits your forest better.

The current tree size is close to what I want it to be when finished so I don't want to change 
things too much. (fig. 10)

Fig. 10



In fig. 10 I have increased the size of the second brush to 16 and lowered the size of the first to 
12. I left the weight at the default but if you want more of the larger trees and less of the 
smaller (or vice versa) then try moving the weight control up or down. Depending on which of 
the two brush controls you made larger, the weight will have a different effect.

So, there's my forests looking a little better than they did before. Less obviously digitally 
placed, a little more random.



But Wait... there's more
I'm not going to go into all the settings of the program right now, I've already been writing 
this damn document far longer than I intended.
But for now I'll just describe a few of other controls, some of which are less-obvious-what-it-
does.

Direction

For a start, in order to seemingly double the amount of brushes I have in my forest (thus 
making them less obviously repeated) I'm going to go into Edit menu, and then under the 
Direction sub-menu, I'm going to activate Randomly Mirror Brushes. This does exactly what 
it says on the tin – it randomly mirrors brushes so that the base tree brush is pointing one of 
two ways. In order for this to work correctly the tree brush must contain no obvious shading 
“hard-coded” into it. Also, if you want a shading layer with your forest then your brush set 
much include both normal and reverse shade brushes.
The other two options in the Direction sub-menu should be equally as obvious what they do 
but just in case...

Mirror Brushes Horizontally will mirror all your base tree brushes so they are displayed the 
opposite way to which they are drawn. This control has no effect if the Randomly Mirror 
Brushes is also selected.

Move Light Source to Opposite Side will move the shading and shadows displayed to the 
opposite side of the brush. Again, this requires reverse shading to work properly if shading is 
required.

Template

From the bottom Control Bar, select Template from the left combo box. There are five 
available controls in the sub-menu combo box (although the last one, Offset Template does 
absolutely nothing currently... fuggedaboudit).

The second to last one, Padding, shouldn't be needed - if your template image was drawn too 
close to the edge then it is possible that shadows or even trees may be cut off on one side of the 
generated forest. If this is so, increasing the Padding size should fix it.

The third option, Opacity Tolerance, raises or lowers the threshold at which the program will 
ignore your template. This is to prevent the forests being larger than intended if, say, a 
gaussian blur is used on the template. Or if the template has some unintended artifacts.
So if your template has a soft edge to it or areas of varying opacity, lowering or raising the 
tolerance will effect how large your forest is.

The first two options, Scale Relative to Template Opacity and Density Relative to Template 
Opacity can be used to affect how your lower opacity template areas appear. They are both 
really a work in progress. (Could be better. Must try harder!)
Using the first control can lower the size of the trees over the low opacity areas by an amount 
relative to your current tree size.
Using the second control will randomly remove trees based on the opacity of the forest. It is 



weighted and removes more trees from a lower opacity area than a high one. This can be 
useful for making the edge of a forest a little more random.

Brush Removal

The controls in this section should be pretty obvious. The exception being Remove Misplaced 
Trees.
The program iterates through each tree from top-left down to bottom-right and places a 
triangle at the base of each tree trunk. It then checks round a bunch of its neighbours to make 
sure that their tree trunks aren't in the triangle. If they are, they don't get drawn.
The two controls in the Removal section of the Control Bar let you increase or decrease the X 
and Y tolerance, thus increasing or decreasing the triangle of misplacedness.
If you feel too many trees are getting removed with this feature then reducing the size of the 
triangle can help.

Brush Weight

The final selection from the left combo box in the Control Bar is Brush Weight. With this you 
can alter the likelihood that a particular brush will be chosen to be in the forest or switch a 
brush off entirely.
If you have a brush in the set you just don't like, select it from the sub-menu combo box and 
set the value of it to zero.
If you have one you like but it is too graphically obvious when it repeats then lower its weight 
down and increase the weights of the others.
If you want a particular brush to appear more than the others, ramp its weight value up.



And Finally...
OK, time to finish off the forest I started earlier.

After I had jittered and scaled the trees, I used the Template controls on it to add variance to 
the low opacity spots. Although if I'm honest, those opacity spots weren't large enough or 
transparent enough to have as much as an effect as I would have liked. Still, they added a little 
to the overall.
I also randomly mirrored the tree brushes for more variance.
I saved all layers as was described earlier.
I opened up the .png files in Photoshop and dragged them into my map (fig. 11)

Fig. 11

All layers are visible in the above image, including the white Mask layer.

I then did a little post imaging on the forests. I selected the shadow layer and filled the 
selection on another layer with a pattern I used for shadowing on the Aronbor map, which 
this is a sister to.
I copied and blurred the tree brush layer and changed the blend mode of the shade layer.
Lastly I used the mask layer to stroke around the outside of the forests and gaussian blurred 
that stroke to make the outsides of the forests a little darker.

And here is the result (fig. 12)



Fig. 12


